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Thank you for purchasing the PENTAX Digital Camera.

This is the manual for “PENTAX PHOTO Browser 2.1” and “PENTAX PHOTO
Laboratory 2.1”, software for your Windows PC or Macintosh for enjoying
images created with your camera. Please read the separate camera operating
manual and this manual before using your camera, “PENTAX PHOTO
Browser 2.1”, or “PENTAX PHOTO Laboratory 2.1”, in order to get the most
out of all the features and functions.

Keep the camera operating manual and this manual safe, as they can be
valuable tools in clarifying and helping you to understand all the camera’s
capabilities.

Regarding copyrights

Images taken using this camera that are for anything other than personal enjoyment
cannot be used without permission according to the rights as specified in the Copyright
Act. Please take care, as there are even cases where limitations are placed on taking
pictures even for personal enjoyment during demonstrations, performances or of items
on display. Images taken with the purpose of obtaining copyrights also cannot be used
outside the scope of use of the copyright as laid out in the Copyright Act, and care
should be taken here also.

Regarding trademarks

*« PENTAX and smc PENTAX are trademarks of PENTAX Corporation.

* PENTAX PHOTO Browser, PENTAX PHOTO Laboratory, PENTAX REMOTE
Assistant are trademarks of PENTAX Corporation.

* The SD logo S is a trademark.

« All other brands or product names are trademarks or registered trademarks of their
respective owners.

Regarding PictBridge

PictBridge allows the user to connect the printer and digital camera directly, using the
unified standard for the direct printout of images. You can print images directly from the
camera through a few simple operations.

Disclaimer

* PENTAX is not responsible for any damages resulting from the direct or indirect use
of this software or repercussive damages, damage to data, programs or other
intangible property, loss of profit or anticipated profit, or dispute with a third party
resulting from the use of this software.

» The specifications of this software are subject to change without notice.

® Symbols used in this manual have the following meanings:

"memo Gives information that is useful to know.

m Gives cautions and notes about the operation.

The screen pictures shown in this manual may differ depending on the
type of computer used.
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Enjoying Your Digital Camera Pictures

D You can use a computer to organize and edit the pictures captured with
your digital camera.

Direct Print

Connect your camera directly to a
PictBridge-compatible printer using the
USB cable. (Not available on a1 .)

Your computer is...
* equipped with a standard USB

interface.
View and record images on « using Windows Me/2000/XP or
; Mac OS 9.01/9.2/X (Ver. 10.1,
AV equipment 10.2, o 10.3),

Connect your cameratoa TV,
DVD recorder or other audiovisual tConnect YOth camera
equipment using an AV cable to 0 a compuler using

. . the USB cable to copy
view and/or record images. the camera images to
a computer.

You can transfer your

images using a built-in

card slot + PC card

adapter or a card reader.

* Remove the card from
the camera. When
transferring images on
the card to a computer
with another device,
make sure to review the
user manual
accompanying that
device.

Use your photo shop|

You can have prints made from
images recorded on your card
at a photo shop.

» Set DPOF settings on your
camera, and get prints from
your photo shop.

« Select the images for prints.



| Use your image data

You can use your e-mail software to attach and send images
by e-mail, or post the images on your website.

* See the operating manual of your e-mail
software for details on how to make
attachments to e-mails.

* See the operating manual of the software

you are using for details on how to use

images on your website.

‘ Use your printer ‘

PENTAX PHOTO Browser 2.1 (p.22 - p.75)
PENTAX PHOTO Laboratory 2.1 (p.76 - p.97)

* View images * Organize and save images

* Printimages + Rename all You can use your printer to

« Save all image data print images transferred to

+ PENTAX-specification RAW data processing your computer. .
Some printers can print

Use a commercially-available image editing directly from memory cards.

software to perform resizing, trimming and * For details, see the

other image editing operations. operating manual of the

- printer yOU are using.

| Save your image data

Images transferred to the computer can
be saved onto a CD-R or other media.




What You Can Do with PENTAX

PHOTO Browser 2.1

PENTAX PHOTO Browser 2.1 is software for viewing, printing and
managing images taken on your digital camera and saved on your
computer.

When you select a folder containing saved images, those images
compatible with PENTAX PHOTO Browser 2.1 automatically appear as
thumbnails. You can select a thumbnail image to view the image at a
larger size.

Files with extensions .bmp (BMP), .jpg (JPEG), .pef (RAW), .pct (PICT),
.png (PNG) and .tif (TIFF) are supported.

This manual describes PENTAX PHOTO Browser 2.1 and PENTAX PHOTO
Laboratory 2.1 with screen images from Windows XP.

The operation of these software applications is nearly the same on Macintosh
with the exception of some keys. For information on Macintosh-specific
instructions, see the sections labeled “For Macintosh” or the online help.

Software Provided

The provided CD-ROM (S-SW34) contains the following software:
*+ PENTAX PHOTO Browser 2.1
*+ PENTAX PHOTO Laboratory 2.1

PENTAX PHOTO Browser 2.1

PENTAX PHOTO Browser 2.1 can perform the following tasks:

» Save image files under the same or a new name, change file names and
file types, copy, cut, paste, rotate and delete.

» Create new folders, change folder names, copy, cut, delete and paste.

» Save image data list.

» Check image data.

» View RAW image data easily.

* Print images.

You can also start RAW image data editing software PENTAX PHOTO
Laboratory 2.1 and PENTAX REMOTE Assistant 1 from within PENTAX
PHOTO Browser 2.1.

*1: PENTAX REMOTE Assistant can only be used together with *Za¢1).



PENTAX PHOTO Laboratory 2.1

Performs color separation processing and other processing on CCD RAW

image data recorded in PENTAX digital camera dedicated format, thereby
enabling images to be saved so as to appear on commercially-available

image viewing and editing software.

PENTAX PHOTO Laboratory 2.1 can also be run as a standalone (,
application.

System Requirements

We recommend the following system requirements to transfer images
from your camera to a computer and to install and use PENTAX PHOTO
Browser 2.1 and PENTAX PHOTO Laboratory 2.1.

Windows System Requirements

® USB Connection

» Computer with Windows Me/2000/XP (Home Edition/Professional)
preinstalled.

» USB port must be standard equipment.

® Application Software

<PENTAX PHOTO Browser 2.1 and PENTAX PHOTO Laboratory 2.1>
(9 languages: English, French, German, Spanish, Italian, Russian,
Chinese [traditional and simplified], Korean, Japanese)

+ OS : Windows Me/2000
Windows XP (Home Edition/Professional)
+ CPU : Pentiumlll or later (Pentium 4 or later recommended)
* Memory : 256MB minimum (512MB or higher recommended)
* Monitor : 1024x768 (1280%1024 or better resolution

recommended) in 24 bit full color (approx. 16.77
million colors)
» Free Disk Space : 250MB or more (500MB or more recommended)

m * In Windows 95/98/NT, you cannot transfer files or use the included
application software using the USB cable.
* We recommend using AC adapter when the camera is connected to the
computer. If the batteries become depleted during image transfer, the image
data or SD Memory Card may be damaged.



Macintosh System Requirements

® USB Connection
» Macintosh with Mac OS 9.01/9.2/X (Ver. 10.1, 10.2 or 10.3) preinstalled.
» USB port must be standard equipment.

‘) * Installation of the USB driver is not necessary.

® Application Software

<PENTAX PHOTO Browser 2.1 and PENTAX PHOTO Laboratory 2.1>
(9 languages: English, French, German, Spanish, Italian, Russian,
Chinese [traditional and simplified], Korean, Japanese)

+ OS : Mac OS 9.0 or later (CarbonLib 1.5 or later)
Mac OS X 10.1.3 or later
+ CPU : PowerPC G3 or later (G4 1.0 GHz or higher
recommended)
* Memory : 256MB minimum (512MB or higher recommended)
* Monitor : 1024x768 (1280%1024 or better resolution

recommended) in 24 bit full color (approx. 16.77
million colors)
» Free Disk Space : 250MB or more (500MB or more recommended)

m * We recommend using AC adapter (sold separately) when the camera is
connected to the computer. If the batteries become depleted during image
transfer, the image data or SD Memory Card may be damaged.

* In Mac OS 8.6, you cannot transfer files using the USB cable.



Installing the Software

Here is the procedure for installing PENTAX PHOTO Browser 2.1 and

PENTAX PHOTO Laboratory 2.1.

PENTAX PHOTO Browser 2.1 and PENTAX PHOTO Laboratory 2.1 can

be installed on top of earlier versions of this software supplied with *£a€ 1)

and #iat DS .

When multiple accounts have been setup in Windows 2000/XP or Mac OS

X, log on with an account that has administrative rights before installing the a
software.

When Using Windows

’ Turn your computer on.

Close any other software that is open.

Z Place the provided CD-ROM (S-SW34) into the CD-ROM
drive on your computer.

The PENTAX Software Installer screen appears.

* If the PENTAX Software Installer screen does not appear
Display the PENTAX Software Installer screen following the steps below.
1) Double-click [My Computer] from the start menu.
2) Double-click the [CD-ROM drive (S-SW34)] icon.
3) Double-click [Setup.exe].

3 You can choose the languages
from the displayed screen.

i PENTAX Software Installer.
PENTAX" scrtware mstarer

The software selection screen —
-_ngnsh )| e

appearS Francais ) M
Deutsch ) B3
Espafiol ) HARE
Italiano )
Pycckuin j

“ UL G




l Click [PENTAX Digital Camera g
Utility]_ PENTAX Software Installer

English ) PENTAX Digital Camera Utility )

Product Registration >)

Back ) Exit )

5 Select your applicable Spp— )
Ianguage in the Select Plasse sslect the |sngusgs that you would lke 1o use

during the installation

Language screen and click
[OK].

QK Cancel

.m0 Some operating environments select the language automatically. Continue
= with the installation in step 6. The installer starts.

ﬁ The installer starts. Click =
[Next]. B i

Itis strongly recommended that you exit allWindows pragrams
before running this Setup Program.

Camera iy Setup
tall PENTAX Digital
.

Click Cancel to quit Setup and close any programs you have
runring. Chck Next to continue with the Setup program

WARNING: T his program is protected by copyright law and
intemational veaies.

Unauthorized reproduction or distibution of this program, or any
portion of . mey resul in severe sivi and crininal penaltes,
and il be prosecuted o the masimum extert possbl under
=

Cancel




7 Confirm the folder name in the
Destination Folder to which
the program files are to be
installed. Click [Next] if no
need to change.

all PENT A Digial Camera Uity in the folloning

& diferent folder, clck Biowse, and select

56 ok to install PENTAX,Digital Camera Utiity by
el 10 exit Selup.

Destination Folder

CA\.\Penta\Digital Camera Utity Browse.

< Back cancel

8 Click [Next] to begin the ®
installation. ‘

Copying of the program files begins.

«Back Cancel

g A message appears after
installation of the software is
finished. Click [Finish] to exit
the installation program.

PENTAM Digtel Camera Uity has been successfully installed.

Press the Finish buttan ta ext this instaliation

The installation is complete.




Product Registration on the Internet

Please click [Product Registration] on the
software selection screen in step 4 (p.8).
A world map for Internet Product
Registration is displayed.

If your PC is connected to the Internet,
click the displayed country or region and
then follow the instructions to register
your product.

Thank you very much for your cooperation.

%

semo Only customers in displayed countries and regions can register their products

on the Internet Product Registration.



When Using Macintosh

Turn your Macintosh on.

Close any other software that is open.

Place the provided CD-ROM (S-SW34) into the CD-ROM

drive on your Macintosh.

Double-click the CD-ROM (S-
SW34) icon.

The contents of the CD-ROM are
displayed.

Double-click the [PENTAX
Installer] icon.

The PENTAX Software Installer
screen appears.

uuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuu

uuuuuuuuuuuu

You can choose the languages
from the displayed screen.

The software selection screen
appears.

60 PENTAX Software Installer

English )

J
Francais ) @A )
Deutsch ) $H=of )
Espaiiol ) BFE )
Italiano )

Pycckuin )

(O



ﬁ Click the OS selection button
that corresponds to your OS.

Follow the instructions on the screen nih ) ————
and continue with the installation. ——

Product Registration >)
Exit )

_ @

Product Registration on the Internet

Please click [Product Registration] onthe ==
software selection screen in step 6 (p.12).
A world map for Internet Product
Registration is displayed.

®o

ustrala:

If your Macintosh is connected to the
Internet, click the displayed country or
region and then follow the instructions to
register your product.

Thank you very much for your cooperation.

&nemo Only customers in displayed countries and regions can register their products
on the Internet Product Registration.



Saving Images on Your Computer

Here is the procedure for saving images captured with your digital camera
onto your computer.

This section describes the method for saving images by connecting your
camera and computer with the USB cable, as well as other methods.

Saving Images by Connecting Your Camera
and PC (For Windows)

Set [Transfer Mode] on the Camera to [PC]
#Ea€ DL is used as an example here. When using *£a£ 1), [Transfer Mode]

does not need to be set. Go to “Connecting Your Camera to Your PC” (p.14).

’ Press the MENU button on the camera.
The [ Rec. Mode] menu or the [[=] Playback] menu appears.

Z Press the four-way controller (» ) to display the [X4 Set-up]
menu.

3 Use the four-way controller (A V) to select [Transfer Mode].

4 Press the four-way controller (»).

A pull-down menu appears.

5 Use the four-way controller (A V) TS
to select [PC]. ) P
Brightness Level +0

[Transfer Mode] settings depend on the Video Out NTSC

connected device. Transfer Mode  <PC__|
Auto Power Off

When connecting to a PC: File # _
[PC] = USB 2.0 (Hi-Speed USB Sensor Cleaning
compatible) MENU Cancel loK oK

[PC-F] =USB 1.1
When printing with a printer:
[PictBridge] (only for compatible printers)

(Ol



ﬁ Press the OK button on the camera.

m » Do not connect the camera to your computer while [PictBridge] is selected for
the [Transfer Mode].

« If the USB transmission speed of the computer is slower than that of the
camera, an error may occur when transferring data. If this occurs, set the
Transfer Mode to [PC-F]. This sets the transfer speed to the USB 1.1 data
transfer rate, thereby reducing the possibility of an error.

Connecting Your Camera to Your PC

D ’ Turn your PC on.

2 Turn off your camera and use the USB cable to connect
your camera and your PC.

Confirm that an SD Memory Card is inserted into your camera.

7

3 Turn your camera on.

The camera is recognized as a [Removable Disk] in [My Computer].

‘q“emo « If the [Removable Disk Drive] dialog appears in Windows XP, select [Open
folder to view files using Windows Explorer] and click [OK]. The window in
step 3 on p.15 appears.

* When using Windows XP, if the SD Memory Card has a volume label, the
content of the volume label name appears instead of [Removable Disk]. A
new unformatted SD Memory Card may show the manufacturer name or
model number.



Saving Camera Images on Your PC

Windows XP is used as an example here.

1

Click [My Computer] from the
start menu.

Double-click the [Removable
Disk] icon.

Double-click the [DCIM] icon.

The [XXXPENTX] (XXX is a three-digit
number) folder appears.

The camera image files are in this
folder.

Drag and drop the
[XXXPENTX] folder into any
desired folder, such as the
desktop or the [My
Documents] folder.

The camera images are saved on your
PC as an entire folder.




Disconnecting Your Camera from Your PC

Windows XP

1 Double-click the & [Safely
Remove Hardware] icon in the
task bar.

The [Safely Remove Hardware]
screen appears.

2 confirm that [USB Mass
@) Storage Device] is selected S e e e S
and then click [Stop]. e
The [Stop a Hardware device] screen
appears.
USB Mass Storage Device at PENTAX "ist DL
[ Display deviee components
3 Select [USB Mass Storage ) ST
Device] and click [OK]_ Confim devices to be stopped, Chaose OK.to continue.

Windows wil altempt to stop the following devices. After the devices are
stopped they may be removed safely

A message appears indicating that the 5 156 M Sterage Dovion
< Generic volume - [E:]
hardware can be Safely removed. < PENTAX DIGITAL_CAMERA USB Device
OK. Cancel

4 ciick [0K].

5 Turn off the camera and
disconnect the USB cable from
your camera and PC.




Windows Me/2000

1

J

‘Wnemo

Double-click the %= [Unplug or
Eject Hardware] icon in the
task bar.

The [Unplug or Eject Hardware]
screen appears.

Unplug or Eject Hardware
e

Confirm that [USB Mass 2l
Storage Device] is selected B e A s
computer.

and then click [Stop].

The [Stop a Hardware device] screen
appears.

Hardnare devices
=us

USB Mass Storage Device at Lacation 0

Properties Stop.
I”" Display device components
¥ Show Unplug/Eject isan on the taskbar Close
Select [USB Mass Storage 2%l
D eVi c e] an d CI i Ck [o K] Confitn devices to be stopped, Chonse OK. to continue.

Windaws wil attempt to stop the fallowing devices. After the devices are
stopped they may be removed safely

A message appears indicating that the e USB Hoss o Devie

S Gieneric valume - (1)

hardware Can be Safely removed (CHPENTAX DIGITAL_CAMERA USE Device

Cancel

Click [OK].

Turn off the camera and disconnect the USB cable from
your camera and PC.

The USB mass storage device will not stop when the files stored on the
removable disk are in use for applications.



Saving Images by Connecting Your Camera
and Macintosh (For Macintosh)

Setting the USB Connection Mode to [PC]

#ea€ DL is used as an example here. When using *#£a£ 1), [Transfer Mode]

does

1

D ?

6
e

not need to be set. Go to “Connecting the Camera and Macintosh” (p.19).

Press the MENU button on the camera.
The [ Rec. Mode] menu or the [[=] Playback] menu appears.

Press the four-way controller (» ) to display the [Xi Set-up]
menu.

Use the four-way controller (A V) to select [Transfer Mode].

Press the four-way controller (»).
A pull-down menu appears.

Use the four-way controller

(A ¥) to select [PC]. QE] Xi Set-up c
Brightness Level +0
[Transfer Mode] settings depend on the Video Out NTSC
; Transfer Mode <“PC
connected device. Auto Power Off _ PiciBiidge
When connecting to a PC: File # C-F
[PC] = USB 2.0 (Hi-Speed USB Sensor Cleaning
compatible) MENU Cancel (oxloK

[PC-F] = USB 1.1
When printing with a printer:
[PictBridge] (only for compatible printers)

Press the OK button on the camera.

» Do not connect the camera to your computer while [PictBridge] is selected for
the [Transfer Mode].

« If the USB transmission speed of the computer is slower than that of the
camera, an error may occur when transferring data. If this occurs, set the
Transfer Mode to [PC-F]. This sets the transfer speed to the USB 1.1 data
transfer rate, thereby reducing the possibility of an error.



Connecting the Camera and Macintosh

’ Turn on your Macintosh.

Z Turn off your camera and use the USB cable to connect
your camera and your Macintosh.

Confirm that an SD Memory Card is inserted into your camera.

'

S

s

3 Turn your camera on.

Your camera is recognized on the desktop as [NO_NAME (or the volume
label of the SD Memory Card if one is registered)].

You can change the folder name.
When the iPHOTO screen appears, close it.

i~ For Mac OS 9.0, it is recognized as [Untitled (or the volume label of the SD
Memory Card if one is registered)].



Saving Camera Images on Your Macintosh

Mac OS X (Ver. 10.2) is used as an example here.

’ Double-click the [NO_NAME]
icon on the desktop.

2 Double-click the [DCIM] icon.

- @ The [XXXPENTX] (XXX is a three-digit
number) folder appears.

The camera image files are in this
folder.

KL (V@) [\ AT « %

3 Double-click the [Macintosh
HD] icon on the desktop.

This opens the [Macintosh HD] folder.




4 Drag and drop the
[XXXPENTX] folder into any
desired folder, such as the
[Macintosh HD] folder.

The camera images are saved into the
[Macintosh HD] folder as an entire
folder.

Disconnecting Your Camera from Your Macintosh

1 Drag [NO_NAME (or the
volume label name on the SD
Memory Card)] on the desktop
to the trash can.

Z Turn off the camera and disconnect the USB cable from
your camera and Macintosh.

Other Methods for Saving Images

Use a card reader or card adapter to send image files directly to your
computer from a memory card with saved images without connecting your
camera and your computer with a USB cable.

For details, please refer to the user’'s manual for your computer or card
reader.



_ @,

PENTAX PHOTO Browser 2.1

This section describes opening and closing PENTAX PHOTO Browser 2.1
and viewing the PENTAX PHOTO Browser 2.1 window, and explains its
functions.

Opening PENTAX PHOTO Browser 2.1

For Windows

’ Select the start menu on the desktop.

2 Select [PENTAX PHOTO
Browser] from [PENTAX
Digital Camera Utility] in the
program menu.

PENTAX PHOTO Browser 2.1 is
opened and the PENTAX PHOTO
Browser 2.1 window appears.

® Closing PENTAX PHOTO Browser 2.1
Select [Exit] from the [File] menu.



For Macintosh

’ Double-click the [PENTAX Digital Camera Utility] folder in
[Applications] on the hard disk.

Z Double-click the [PENTAX
PHOTO Browser] program
icon.

PENTAX PHOTO Browser 2.1 is
opened and the PENTAX PHOTO
Browser 2.1 window appears.

® Closing PENTAX PHOTO Browser 2.1

Select [Quit PENTAX PHOTO Browser] in [PENTAX PHOTO Browser]
on the desktop menu bar.

(Ol



This section explains the PENTAX PHOTO Browser 2.1 window layout,
names and functions.

Each pane can be resized from side to side and up and down. Drag or
double-click the Address bar, Folder tree pane, Image data pane or
Preview pane to remove it from the browser window and move it to a
different position. Alternatively, click |3 on the top right of each pane to
close that pane. (For Macintosh, click a pane or drag the margin to remove
the pane.)

Click = (Default Position) to return the pane to the default position.

About the PENTAX PHOTO Browser 2.1 Window

Menu bar Tool bar Thumbnail pane

Folder tree pane Address bar

B8 PENTI X PHOTO Browser
Fle Edt!view Tool Hep

(OIEE

@ Destton il
= () My Documents

A m
=1 (5 my P

5 my Computer
1 My Network laces

IMGPOIO3PEF 1MGPOO0S PEF IMGPO007.JPG 1MGPO00 JFG IMGPODT3.0PG IMGPD0Z! PEF
WEO0E14GIBPY | Y25/2005 14344 P | /25/2005 LO7EGAN | W2S/2008 TO7ERAN | 3/25/2008321:0BPh | 3425/20051:4320Ph

5 ] ]

IMGPOO54 FEF IMGPO3S1.JPG IMGPD403.IPG
O5/20051:4306 P | /25/20051:43:10Pn || 2502005 14322 P | 25/2008 14828 P | 3/25/20081.07.88 AN | 3425/20051.07.55 AN

Il -

sme PENTAR-DA single AF Single shosting
Automatic Flash off
izsses  FietneMG c « off
perture ivity 00 Phote Natural ul off
Capture mode Picture {flacro) dedpixels  3008:2008 Saturati 2 Fin i i
Meterngmode  Muli-seqmentm...  Qualty RAW Sharpness 2 Shooting date/time  6/25/2005 4:5L.,
White balace Automatic Exposure compe... 0.0 Contrast 2 Camera model PENTAX *ist DL

By

=] >
1668

Local Disk Drive —‘

Preview pane Image data pane Status bar

1 object(s) selecked | 10,552 KB | Dik free space:




® Address bar

The address of the currently displayed folder appears here.
Double-click the address bar to remove it from the browser window and
move it to a different position. (For Macintosh, click the Address bar or
drag the margin to remove the Address bar.)

® Folder tree pane

Internal data on your computer appears here as a folder tree. Select the
folder containing saved image files here.

Also, the Folder tree pane handles operations such as creating new
folders, deleting folders and moving/copying folders.

Double-click or drag the top bar to remove the Folder tree pane from the
browser window and move it to a different position. (For Macintosh, click
the Folder tree pane or drag the margin to remove the pane.)

® Thumbnail pane

Files in the folder selected in the Folder tree pane appear here. Select
from five file display methods. When a thumbnail image is selected in the
Thumbnail pane, the image appears in the Preview pane and the image
data appears in the Image data pane.

® Preview pane

An image selected in the Thumbnail pane appears in this pane.
Double-click the top bar to remove the Preview pane from the browser
window and move it to a different position. (For Macintosh, click the
Preview pane or drag the margin to remove the pane.)

® Image data pane

The image data for the image selected in the Thumbnail pane appears here.

Double-click the top bar to remove the Image data pane from the browser
window and move it to a different position. (For Macintosh, click the Image
data pane or drag the margin to remove the pane.)

Place the cursor over a cell dividing line at the top of the pane and drag it
to resize the cell. (For Macintosh, drag at the desired position to resize the
cell.)

The following items appear:

Data Contents Example

Lens name Shows lens type smc PENTAX-
FA 50mm F1.4

Focal length Focal length when shooting (in mm)  50mm

Shutter speed Shutter speed when shooting 1/250sec

(in seconds)

Aperture Aperture value when shooting F8.0




Data Contents Example
Capture mode Capture mode when shooting Auto Picture
(Normal)
Metering mode Metering mode when shooting Multi-segment
metering
White balance White balance mode Automatic
Color temperature Color temperature (units: Kelvin) *1 .
Fine tune A-B Amber - Blue fine tune ™t
Fine tune M-G Magenta - Green fine tune ™ .
Sensitivity ISO sensitivity when shooting 200
Recorded pixels Number of recorded pixels 3008x2000
Quality Recording quality Better
Exposure Exposure compensation 0.0
compensation
Autofocus mode Autofocus mode when shooting Single AF
Autofocus area mode Autofocus area mode when shooting  Automatic
Color space Color space mode sRGB
Photo finish Photo finish settings Bright
Saturation Saturation settings 0
Sharpness Sharpness settings 0
Contrast Contrast settings 0
Drive mode Drive mode settings when shooting Single shooting
Flash mode Flash mode settings when shooting  Flash off
Bracket Bracket settings when shooting Off

Multi-exposure

Multi-exposure settings when shooting Off

Firmware/Software
version

Version of the software when images

were last saved "2

*ist DL Ver. 1.00

Shooting date/time

Date and time shot

2005/06/25
10:00:00

Camera model

Camera model

PENTAX *ist DL

*1: Processing details when using PENTAX PHOTO Laboratory 2.1 appear.
*2: Information on the camera’s firmware appears for captured images.

e Status bar

The status of PENTAX PHOTO Browser 2.1 appears.

The following items appear:

* Number of objects in the selected folder, total folder size (not including
subfolders) or number of selected objects and total size

+ Available disk space for selected drive

» Progress status when loading thumbnails

+ Identification of local disk, removable disk and network



Menu Bar

This executes functions or sets various settings of PENTAX PHOTO

Browser 2.1.

For Macintosh, the menu bar appears at the top of the desktop.

File menu

Create New Folder

This creates a new folder in the location specified on
the Folder tree pane. (p.73)

Open This opens the selected folder. For an image
selected in the Thumbnail pane, it displays the image
in a new main image window.

Rename This changes the name of the selected file or folder.
(p.71)

Rename All This changes the names of all selected files. (p.72)

Page Setup This sets printing options such as margins, headers/
footers, and number of copies. (p.57)

Print This prints the selected image file. (p.52)

Properties The properties of the selected file or folder appear.
(p.74)

Exit This closes PENTAX PHOTO Browser 2.1.

(For Macintosh, select [Quit PENTAX PHOTO
Browser].)

Edit menu

Undo This undoes the previous file operation.

Cut This prepares the selected file or folder to be moved
to a different location. (p.67)

Copy This copies the selected file or folder. (p.67)

Paste This copies the cut or copied file or folder into the
selected folder. (p.67)

Delete This deletes the selected folder or image. When a

Check Selected Image
Uncheck Selected Image

Uncheck All
Select All

Invert Selection

folder is deleted, all files in the folder are also deleted.
(p-70)

This checks the selected file.

This unchecks the selected file.

This unchecks all images.

This selects all files within the currently open folder.

This unselects all selected files and selects all
unselected files within the currently open folder.




View menu

Tool Bar This shows or hides the Tool bar.

Folder Tree This shows or hides the Folder tree pane.

Preview This shows or hides the Preview pane.

Address Bar This shows or hides the Address bar.

Status Bar This shows or hides the Status bar.

Image Data This shows or hides the Image data pane.

Default Position This returns each pane to its default position.

Filter This sets the type of file that appears in the
Thumbnail pane. Uncheck the items you want to
hide. Select from the following four items:

PENTAX Image: Images captured with your
PENTAX camera

Other Image : Images other than those captured
with your PENTAX camera (JPEG,
TIFF, BMP, PNG, PICT)

Folder : Folders

Other : Files not compatible with PENTAX
PHOTO Browser 2.1

Sort by This specifies the order in which objects appear in the

Thumbnail Caption

Thumbnail (Smallest)
Thumbnail (Small)
Thumbnail (Medium)
Thumbnail (Large)
Details

Move

Slideshow

Thumbnail pane and specifies ascending or
descending order.

You can select from File Name, File Size, File Date/
Time, File Type, Shooting Date/Time, Image Size
and Lens Name.

This sets the captions of objects that appear in the
Thumbnail pane. File Name, File Date and File Time
appear by default.

The smallest size thumbnail appears in the
Thumbnail pane.

A small size thumbnail appears in the Thumbnail
pane.

A medium size thumbnail appears in the Thumbnail
pane.

A large size thumbnail appears in the Thumbnail
pane.

Image details appear in the Thumbnail pane without
an image.

Select [Back] to return to the previously opened
folder, [Forward] to move forward one folder, and
[Up] to move up one folder in the directory tree.

Selected or checked images appear in order. (p.49)




Tool menu

Save Image Data List

PENTAX PHOTO
Laboratory

PENTAX*REMOTE
Assistant™!

Use the check boxes to save the image data from
multiple folders into one CSV format file. If no images
are selected or checked, all the image data in the
current folder is saved. (p.48)

This starts PENTAX PHOTO Laboratory 2.1. Specify

the applicable image files within the Thumbnail pane
of PENTAX PHOTO Browser 2.1. (p.76)

This starts PENTAX REMOTE Assistant.
PENTAX REMOTE Assistant can be used by
installing it in the same folder as PENTAX PHOTO
Browser 2.1 and using it together with *Za¢1).

Options This sets various settings for PENTAX PHOTO
Browser 2.1. (p.60)

Help menu

Help Topics This shows PENTAX PHOTO Browser 2.1 help
contents.

Index This shows PENTAX PHOTO Browser 2.1 help index
search. (This command is not available for
Macintosh.)

What's This? This shows pop-up tips when an icon or command

About PHOTO Browser

button is clicked.

This shows PENTAX PHOTO Browser 2.1 version
information. (For Macintosh, select [About PENTAX
PHOTO Browser] on the [PENTAX PHOTO Browser]
menu.)

*1: PENTAX REMOTE Assistant is not included in the CD-ROM (S-SW34). The
latest version can be downloaded from the PENTAX website.
This menu function can be used if PENTAX REMOTE Assistant is already

installed.

(Ol



Tool Bar

Frequently used functions are provided as Tool bar buttons. You can
execute these functions easily from the Tool bar.

Double-click the Tool bar to remove it from the browser window and move
it to a different position.

1 2 3
||

T 6 7 8 9 10 11 12 13

| | |
@|m%mmwmw

|
VO

\@EEDEEW%@ﬁMW@

14 15 16 17 18 19 20 22 23 24 25

Number Icon (button) Content

1 @ This opens the previously opened folder.
Back

2 This opens the folder which was open before
@ using the [Back] button.
Forward

3 [ﬂ This moves up one folder in the directory tree.
Up

4 T This changes the names of all selected files.
Uy (p.72)
Rename All

5 E; This prints the selected image file. (p.52)
Print

6 @ This undoes the previous file operation.

Undo

This prepares the selected file or folder to be
moved to a different location. (p.67)

+*

(@)
=




Number Icon (button)

Content

8 : This copies the selected file or folder. (p.67)
5
Copy
9 This copies the cut or copied file or folder into the
l:j selected folder. (p.67)
Paste
10 ﬁ This deletes the selected file or folder. (p.70)
Delete
11 The selected image file appears in the main
|:| image view window. (p.38)
View Image
12 Click [ to select the type of file that appears in the
‘ii" Thumbnail pane. Uncheck the items you want to
Filter hide. Select from the following four items:
PENTAX Image: Images captured with your
PENTAX camera
Other Image : Images other than those
captured with your PENTAX
camera (JPEG, TIFF, BMP, a
PNG, PICT)
Folder : Folders
Other : Files not compatible with
PENTAX PHOTO Browser 2.1
13 e Click [ to select the sort key and ascending/
i ﬂfji' descending order from the pull-down menu.
Sort by Thumbnails are sorted according to the selected
order.
14 The smallest size thumbnail appears in the
% Thumbnail pane. (p.38)
Thumbnail
(Smallest)
15 A small size thumbnail appears in the Thumbnail
E pane. (p.38)
Thumbnail (Small)
16 A medium size thumbnail appears in the
I:F Thumbnail pane. (p.38)
Thumbnail (Medium)
17 A large size thumbnail appears in the Thumbnail

[ ]

Thumbnail (Large)

pane. (p.38)




Number Icon (button)

Content

18 Image details appear in the Thumbnail pane
% without an image.
Details
19 This returns the window layout of PENTAX
E PHOTO Browser 2.1 to the default settings.
Default Position
20 Selected or checked images appear in order.
fid (p49)
Slideshow
21 This saves additional information for all specified
L%] PENTAX PHOTO Browser 2.1 compatible image
Save Image Data files into one CSV format file. (p.48)
List...
22 This starts PENTAX PHOTO Laboratory 2.1.
é Specify the applicable image files within the
PENTAX PHOTO Thumbnail pane of PENTAX PHOTO Browser
Laboratory 2.1. (p.76)
23 This starts PENTAX REMOTE Assistant.
0 PENTAX REMOTE Assistant can be used by
PENTAX REMOTE installing it in the same folder as PENTAX
Assistant PHOTO Browser 2.1 and using it together with
*iatD.
24 ol This sets various settings for PENTAX PHOTO
L@ Browser 2.1. (p.60)
Options
25 ? This shows PENTAX PHOTO Browser 2.1 help
Famy contents.




Main Image Window

Menu bar Tool bar

IMGPOO30. PEF

x

Lens name smc PENTAR-DA ... Color kemperature - Autofocus mode  Single AF Drive mods Single: shooting

Focal length 45mm Fine tune A-6 Autofocus area ... Automatic Flash made Flash off
Shutter speed 1j2Ssec Finetune MG - Color space L Bracket off

Aperture F5.6 Sensitivity 400 Phata finish Natural Multi-exposure f

Capturs mods Fickure (Macro) Recorded pixels  3008x2008 Saturation H Firmware/Softw..,  *istDL  Wer 1L
Metering mode Multi-segment m...  Quality RAW Sharpness H Shooting datsftime  6/25/2005 4:51:
white balance Automatic Exposure compe... 0.0 Contrast z Camera model PENTAX *ist DL

Image data pane Image view area

® Menu bar
This executes functions or sets various settings of the main image window.

File menu

View Browser This shows the file browsing screen.

Open This opens the [Open] dialog to select the file to open.
If a check mark is next to “Open in new window”, a
new Main image view window opens and the
selected image appears when a file is selected and
[Open] is clicked. (p.38)

Save as This saves the image being viewed in JPEG, TIFF,
BMP, PNG or PICT format. (p.45)

Page Setup This sets the page setup information for printing the

selected image. (p.57)




File menu

Print This prints the current image. (p.52)
Properties Image file data appears. (p.44)

Close This closes the main image window.
View menu

Tool Bar This shows or hides the Tool bar.

Image Data This shows or hides the Image data pane.

Previous Image

Next Image

Slideshow
Fit to Window
Enlarge

Reduce

Life size

Rotate View

(Counterclockwise 90°)

Rotate View
(Clockwise 90°)

Arrange Windows

The previous image appears when there are multiple
images in the main image view window. This button
cannot be selected if there are no images to view.

The next image appears when there are multiple
images in the main image view window. This button
cannot be selected if there are no images to view.
Selected or checked images appear in order. (p.49)
This fits the image to the window size. (p.42)

This doubles the view magnification of the image

appearing in the image view area.
The maximum view magnification is 4 times. (p.42)

This halves the view magnification of the image
appearing in the image view area.
The minimum view magnification is 1/16. (p.42)

This sets the view magnification of the image
appearing in the image view area to life size. (p.42)

This rotates the image 90° counterclockwise. This
does not affect the data.

This rotates the image 90° clockwise. This does not
affect the data.

This arranges multiple main image windows.




Tool menu

Auto Image Fix

Rotate Image

This automatically adjusts the brightness, contrast
and color tone. Select Strong or Slight.

Image data is rotated. Uncompressed images are
rotated as is. When performing lossless rotation of an
unprocessed JPEG image, the [Save File] dialog
opens before the image appears. (p.46)

Options This sets various settings for PENTAX PHOTO
Browser 2.1. (p.60)

Help menu

Help Topics This shows PENTAX PHOTO Browser 2.1 help
contents.

Index This shows PENTAX PHOTO Browser 2.1 help index
search. (This command is not available for
Macintosh.)

What's This? This shows pop-up tips when an icon or command

About PHOTO Browser

button is clicked.

This shows PENTAX PHOTO Browser 2.1 version
information. (For Macintosh, select [About PENTAX a
PHOTO Browser] on the [PENTAX PHOTO Browser]

menu.)

® Tool bar

Frequently used functions are provided as Tool bar buttons. You can
execute these functions easily from the Tool bar.
Remove the check mark next to [Tool Bar] on the [View] menu to hide the

Tool bar.

EIES S

9 10 11 12

o

L=

s B

Wibdaak
=

13 17 18 19



Number Icon (button)

Content

1 — This shows the file browsing screen.
e
View Browser
2 This opens the [Open] dialog to select the file to
‘gi? open. If a check mark is next to “Open in new
Open window”, a new Main image view window opens
and the selected image appears when a file is
selected and [Open] is clicked.
3 This saves the image being viewed in JPEG,
B TIFF, BMP, PNG or PICT format. (p.45)
Save as
4 G This prints the current image. (p.52)
Print
5 %::} This shows selected file properties. (p.44)
O
Properties
6 The previous image appears when there are
< multiple images in the main image view window.
Previous Image This button cannot be selected if there are no
images to view.
7 The next image appears when there are
D multiple images in the main image view window.
Next Image This button cannot be selected if there are no
images to view.
8 = Selected or checked images appear in order.
i (p49)
Slideshow
9 = This fits the image to the window size. (p.42)
i)
Fit to Window
10 This halves the view magnification of the image
q appearing in the image view area.
Reduce The minimum view magnification is 1/16. (p.42)
11 This doubles the view magnification of the
Q, image appearing in the image view area.
The maximum view magnification is 4 times.
Enlarge

(p.42)




Number Icon (button)

Content

12 m—— This sets the view magnification of the image
|00 appearing in the image view area to life size
Life size (1:1). (p-42)
13 The current view magnification appears. You
[1554 % -] can also set the view magnification by selecting
it from the pull-down list, or by directly inputting
Zoom the magnification. (p.42)
14 This rotates the image appearing in the image
% view area 90° to the left (counterclockwise).
Rotate View (p-41)
(Counterclockwise 90°)
15 This rotates the image appearing in the image
|§7 view area 90° to the right (clockwise). (p.41)
Rotate View
(Clockwise 90°)
16 = Click - and select [7] or [£ to automatically
D_‘ adjust the brightness, contrast and color tone.
Auto Image Fix Select Strong or Slight.
17 Click | and select & or [ to rotate the image
@:@ T data. Uncompressed images are rotated as is.
When performing lossless rotation of an
Rotate |
clate Image unprocessed JPEG image, the [Save as] dialog
opens before the image appears. (p.46)
18 The PENTAX PHOTO Browser 2.1 setup
L@ screen appears. This sets various settings for
Options PENTAX PHOTO Browser 2.1. (p.60)
19 ? This shows PENTAX PHOTO Browser 2.1 help
" contents.
Help

® Image View Area
The image selected in the Thumbnail pane of PENTAX PHOTO Browser
2.1 appears.

® Image data pane
The image data appears for the image appearing in the image view area.
Remove the check mark next to [Image Data] on the [View] menu to hide
the Image data pane.
Place the cursor over a cell dividing line at the top of the pane and drag it
to resize the cell. (For Macintosh, drag at the applicable position to resize
the cell.)




Viewing Images

Display the images saved on your computer.

’ Open PENTAX PHOTO Browser 2.1.

Fle Edt View Tool Hel

Q@ L0 e o BEEFOE S o

?
e
Address  [er\documents and settingsitestimy documentsimy pictures =
Desktop
= (2 My Documents
My Music CJ
5 100PENTY
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- i, 3% Fopy (A1)
e Locsl Dk (C2)
4 2, CD Drive (D) 00PENTR
& [ Control Panel
4 ) Shared Dosumerts
{5 sereenis Doouments
4 () My Documents
- &3 My Network Places
Lens name Color temperature Autofocus mode Drve mode.
Focallength Fine tune A6 Autofocus srea Flach mode
Shutter speed Fine tune -G Color space
Aperture Senstiviy Photo frich Mult-exposure
Capture mode Recorded pixels Saturation Firware/Softu.
Hkering mode Guaity Sharpress Shooting dateftine
ihte balance Exposre compe... Conrast Camera model
< >
1 object(s) | 0K | Disk free space 16,5 Local Disk Drive
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In the folder tree, select the folder containing the image
file to view.

Images in the selected folder appear as thumbnails in the Thumbnail
pane.

PENTAX PHOTO Browser [BEE

00R ™S S+Linm~ o BEFIE o Rd0Ra
? =

Addiess [erhde

5 e
b 3% Flopy (4) arg] 0 | s O
¥ e Local Disk (C:)

# . CDDrive (D:) IMGPOO03.PEF IMGPDO0S PEF IMGPDOO7.IPG IMGPOO03 JPG IMGPI0T3.JPG IMGPO021 PEF
w O IS/ TASTEPY | /2SS AGAAFY | V2SIDIS TOTSEAN | 2005 10MSEAN | V2SS IZLOBPL | 2S/Z006 T4S20P
=L

1 53 My Documents
5 My Network Ploces

[£ru] o o ara] o
INGPO023.PEF 1MGPON2S PEF IMGPOO0 PEF IMGPODS4 PEF IMGFO391 PG IMGPO4O3IPG

5/25(2005 T430BFY | 3/25/20051:4310Fh | 3/25/20051:4372F | /25/2005 14326 Ph | /25/2005 1.O7.56 AN | 3/25/2005 1:07:564h
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Lens name Color temperature: Autofocus mode. Drive mode.

Focal length Fine: tune A-B Autofocus area ... Flash mode.

Shutter speed Fine tune M-G Color space Bracket

Aperture Sensitivity Photo finish Multi-exposure

(Capture mode Recorded pixels Saturation Firmware/Softw,

Metering mode Quality Sharpress Shacting dateftime

White balance Exposure compe. .. Contrast era model

< | >
23 object(s) | 199,202 KB | Disk free space 16 GB Local Disk Drive.

You can change the size of the thumbnail image. In the [View] menu, select
[Thumbnail (Smallest)], [Thumbnail (Small)], [Thumbnail (Medium)], or
[Thumbnail (Large)]. Alternatively, click the [, [[Z, [/, or [I] icon on the Tool
bar.

Select an image in the Thumbnail pane.
Select one of the following methods for viewing an image:

* Click the image to view. The image is framed in blue.
Hold down the Ctrl key or Shift key to select multiple images. (For
Macintosh, hold down the Command key or Shift key to select multiple
images.)

* Check & the image to view.

Multiple images can be selected. Images from multiple folders can also
be selected.



¢ Click the image to view and then select [Check Selected Image] -
[Invert Selection] from the [Edit] menu.

4 Select [Open] from the [File] menu or click the [ ] icon on

the Tool bar.

The main image window opens and the image appears.
Double-click the image file to view in the Thumbnail pane. The main
image window opens and the image appears in one step.

® RAW image file display

PENTAX PHOTO Browser 2.1 allows you to select between [Simple

display] and [Auto RAW display] when displaying RAW image files in the

main image window. (p.62)

Simple display  : Images can be viewed quickly, but image quality is
inferior.

Auto RAW display: It takes time to display the actual raw data, but the
image quality is superior.
Select from three levels for the processing ratio on the
[View] tab of the [Options] dialog. (p.62)



Rotating the Image View

The image in the image view area can be rotated 90°, 180°, or 270° to the

right (clockwise) or left (counterclockwise).

/

Select [Rotate View (Clockwise 90°)] or [Rotate View
(Counterclockwise 90°)] from the [View] menu in the main
image window.

Alternatively, click the & or =¥ icon on the Tool bar.

The image appears rotated.

To save the rotated image, use [Rotate Image] on the [Tool] menu. (p.46)
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Lens name
Focal length
Shutter speed
Aperture
Capture mode
Metering mode
White balance
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smc PENTAX-DA ..

19mm
135058
F&.0

Auta Picture (Mo,
Multi-segment m. ..

Auknmatic

Color temperature -

Fine tune A-E

Fing tune M-a
Sensitivity
Recorded pixels
Quality

Exposure compe. ..

200
3008x2000
Best

0.0

Autofocus mode

Autofocus area ...

Color space
Phato finish
Saturation
Sharpness
Contrast

single AF
Automatic
sRGE
Hatural

z
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Drive mode:

Flash mode:
Bracket
Multi-exposure
Firmware/Softw, .,
Shooting daketime
Camera model

Singls shc
Flash off
off

off

wist DL
8i251200
PENTAX *

L2




Changing the View Magnification

You can change the image view magnification of the image appearing in
the image view area.

’ Select [Fit to Window], [Enlarge], [Reduce] or [Life size]
from the [View] menu in the main image window.

Alternatively, click the =], &/, & or [« icon on the Tool
bar.

The image view magnification can be adjusted from 1/16 to 4 times.

Enlarged view

IMGPO0Z5.PEF
view Tool Help

&)

Lens name smc PENTAX-DA ... Color kemperature - Autofocus made Single AF Drive mode Single she
Focal length 29mm Fine tune A-B - Autoforus area ... Automatic Flash mode: Flash off
Shutter speed 1{25sec Fine tune M-G Colar space sRGE Bracket OFf
Aperture F5.6 Sensitivity 400 Phota Finish Matural Multi-gxposure CFf
Capture mode Auto Picture (Ma..,  Recorded pixels 30082008 Saturation z Firmweare/Softw,..  *ist DL
Metering mode Multi-segment m..,  Qualiy RAW Sharpness z Shooting dateftime ~ &/25(200!
White balance Automatic Exposure compe... 0.0 Contrast 2 Camera model FENTAX *
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Reduced view

Fle View Tool Help
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Lens name smc PENTAX-DA ... Color kemperature Autofocus mode Single AF Drive mode Single shc
Focal length 29mm Fine tune A-B Autofocus area ... Automatic Flash mode: Flash off
Shutter speed 1/25sec Fine tune M-G —— Color space sRGE Bracket OFf
Aperture F5.6 Sensitivity 400 Phota Finish Watural Multi-exposure OFf
Capture mode Auto Picture (Ma...  Recorded pixels 3008x2008 Saturation 2 Firmware/Softw...  *ist DL
Metering mode Multi-segment m...  Quality RAW Sharpness 2 Shooting dakeftime /257200
White balance Automatic Exposure compe... 0.0 Contrast 2 Camera model PENTAX *
£ 2

L=~ You can also enlarge or reduce the view by directly inputting the numerical
value of the maghnification in the View Magnification box 3 on the Tool

bar.




Hiding the Tool Bar and Image Data Pane

You can set whether to show or hide the Tool bar and image data pane in
the main image window.

1

Select [Tool Bar] or [Image Data] from the [View] menu in
the main image window and uncheck the item.

The Tool bar or image data pane is hidden.

5 1MGPOD25.PEF

Fle View Tool Help

) To display the Tool bar or image data pane, select [Tool Bar] or [Image Data]

from the [View] menu in the main image window and check the item.

Displaying Image Properties

You can display file data for the image file appearing in the main image
window. (p.74)



Saving an Image

You can save the displayed image using any of the following file formats.
RAW data can be saved with any of these formats to view the image with

image processing software.

JPEG

: JPEG image with image data

TIFF (8 bit) : TIFF image with image data
TIFF (16bit) : High quality TIFF image with image data

BITMAP
PNG
PICT

: BMP image without image data
: PNG image without image data
: PICT image without image data

’ Select [Save as] from the [File] menu in the main image

window or click the icon on the Tool bar.

The [Save as] dialog appears.

If RAW data is viewed in Simple display or is reduced, the message
[Image is shown in simple display mode. Do you wish to return image to
full size?] appears. If [No] is selected, the image is saved as it is
displayed. The quality is inferior to that of an image processed to full size.

Specify [Save in], [File name] and [Save as type], and then

click [Save].

Save As

Savein |3 TO0PENTX

IMEPOOO7 IMGPOOOS IMGPO013
W
Filename:  [IMGPO013

Save as type: |JPEG j Cancel

The image is saved.




Saving a Rotated Image

Data of the displayed image is rotated 90° left or right. Rotation of the
image may take time depending on the size of the image.

A warning message appears when closing the main image window without
saving the image or when clicking [« [].

’ Select [Rotate Image], [Counterclockwise 90°] or
[Clockwise 90°] from the [Tool] menu in the main image
window, or click ~ on the right of the icon and then

click the € or [ icon.

IMGP0D1 3. JPG:
Tool Help
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S | J l | Eia g |
Lens name smc PENTA-DA ... Color temperature Autofocus mode  Single AF Drive: mods Single she
Focal length 19mm Finetuns &8 -oeer Autofocus area ... Automatic Flash mods Flash off
Shutter speed 1/350sec Finetung MG woeer Color space SRGE Bracket off
Aperture Fa.0 Sensitivity 200 Photo finish Natural Mub-exposure OFF
Capture mode Auto Picture (Ho... Recorded pixels  3008x2000 Saturation 2 Firmuare/Softw...  #ist DL
Metering made Multi-segment m...  Quality Best Sharpness B Shaating dateftime  6/25/200!
white balance futomatic Exposure compe... 0.0 Contrast 2 Camera model PENTAX *
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The image data appears rotated. When performing lossless rotation of
an unprocessed JPEG image, the [Save File] dialog opens before the
image appears.

2 Select [Save as] from the [File] menu in the main image
window or click the [7] icon on the Tool bar.

The [Rotate Image] dialog appears.



3 Specify [Save in], [File name] and [Save as type], and then
click [Save].

Rotate Image E
Savein | 3 100PENTX | « @k B
-~
IMEPO007 IMGPONOS IMGPO013

b
Save I
Save as type: I LI Cancel |

File name:

A

The image is rotated and saved.




Use the check boxes to save the image data from multiple folders into one
CSV format file. If no images are selected or checked, all the image data
in the current folder is saved.

Saving a List of Image Data

’ Select [Save Image Data List] from the [Tool] menu in the
PENTAX PHOTO Browser 2.1 window or click the icon
on the Tool bar.

The [Save Image Data List] dialog appears.

Save Image Data List... @g|
Save in |."_‘| My Documents j = Bl
jMy [Music
ﬂMy Pictures
|[IPEMNTAX
File name: [
Save astyper [Information List [*.C5V) =] Caree]

Z Specify the file name and save destination, and then click
[Savel].

The image data is saved in CSV format.

L=~  When thumbnail images are checked, data is saved only for those images.
Image data is also saved for checked images contained in other folders. When
a thumbnail image is selected, only data for the selected image is saved.



Continuous Image Playback in a Slideshow

This section explains how to set up and operate the slideshow.

’ Select an image or folder in the PENTAX PHOTO Browser
2.1 window.

2 select [Slideshow] from the [View] menu or click the
icon on the Tool bar.

The Slideshow screen and Slideshow control panel open.

Slideshow screen

Slideshow control panel



Number Icon (button) Content

1 First Image Returns to the first image. When this is pressed
during a slideshow, the first image appears and the
slideshow pauses.

2 Rewind Rewinds slideshow. When this is pressed during a
slideshow, the nextimage appears and the slideshow
pauses.

3 Previous Image Slideshow is played in reverse order.

4 Pause Pauses slideshow.

5 Play Plays slideshow.

6 Fast Forward Fast-forwards slideshow. When fast-forwarding
during a slideshow, the next image appears and the
slideshow pauses.

7 Last Image Shows last image. You can use this during a
slideshow. The lastimage appears and the slideshow
pauses.

8 Stop Stops slideshow.

3 Press the Play button.

The slideshow starts.

Slideshow Settings

When viewing the slideshow, select between a single window and a dual
window. Additionally, view the slideshow in single full screen or dual full
screen mode (only if the computer is compatible with dual screen display).

Set the slideshow order from the [Slideshow] tab on the [Options] dialog.
The order for frame advance during the slideshow is determined by the
View Order setting on the [Frame Advance] tab of the [Options] dialog.

(p-65)



Select from one of the four display patterns below.

Single window

A

Dual window

] ]
A B

Single full screen

A

L —
RS N E—

Dual full screen

A

® Image display order for dual window

When using dual window or dual full screen, select the display pattern for

images on the primary and secondary monitors.

Advance in order

Primary
(A)

Secondary

(B)

Advance alternate

Primary
(A)

Secondary

(B)

n n+1 (==3| n+2 n+3
n+1 n+2 (—>| n+3 n+4
n n n+2 n+2
n-1 n+1 |=—| n+1 n+3

(Ol



Advance two frames

Pri
r|(r/rl?ry n-2 n n+2 n+4

Second
e | n- n+1 n+3 n+5

Set primary image

Primary
(A) n

Sec?é')dary nt1 |=>| n+2 |=—>| n+3 |—>| n+4

Printing an Image

When printing image files, select between Print Index and Print Photo.

Print Index Prints a thumbnail and image data for an image.

Print photo Prints a high-quality print of an image. You can print multiple
images on one page or print one large image on multiple pages
using partition printing.

Using Print Index

’ In the Thumbnail pane of the PENTAX PHOTO Browser 2.1
window, select the images to print.

Z Select [Print] from the [File] menu.
Alternatively, click the icon on the Tool bar.

The [Print] dialog appears.



J  Select the [Print Index] tab.

Print... El@
Print e | Print phota |
Preview Layout
o o o
Murnber of images per page [ = H) Bl243) had
Caption
Position |Eutlnm center j
Contents [ File: riame
[w| File: datetime
[ Shooting date/time
Fort [l |
Size Buto A
P PN Printer NN,
Page Setup Printer Settings ‘ 1.9 Cancel ‘

4 Make the layout and caption settings.

ltem Description
Preview This displays a preview using the specified settings.
Layout Select from three layout patterns.

Number of images per
page

From the list, specify the number of images to print on
one page.

Caption The caption settings are explained below. The
contents that appear depend on the selected layout.
Position Select the image caption position from the list.
Contents Specify the data that may be printed from the list.
Font Select a font from the list. The default setting is the
standard system font.
Size Select a font size from the list.
Printer The name of the printer to be used appears here.




L=~ + The image size is calculated automatically from the margins, number of
images, and caption size.
« Click the [Page Setup] button to make the page settings. (p.57)
« Click the [Printer Settings] button to make the printer settings. (p.58)

J  Click [OK].

Printing starts.

Using Print Photo

’ In the Thumbnail pane of the PENTAX PHOTO Browser 2.1
window, select the images to print.

Z Select [Print] from the [File] menu.
Alternatively, click the 53 icon on the Tool bar.

D The [Print] dialog appears.



3 Select the [Print photo] tab.

Print...

Print Ind=x ~ Print photo }

Preview

Page Setup

Layout
~ - »
Images per page
Multi-page printing
Allocating images Mo trimring hd
Position Center <
Space [Verlical) =lmm  Space Horizontal) —mm
Fit to page I
Print Shooting Date and Time
Prink Time:
Pasition [Batiom Right finsice) JE2 [
Font [ial ] | O ves
Separator  |Space x| Testcolor |Orangs |
Format ['rree oD ]| Siee [t |
E<< < N\[ Finter WOLO000000M
Printer Settings ‘ 1] | Cancel ‘

4 Make the layout and caption settings.

ltem Description
Preview This displays a preview using the specified settings.
Layout Select from three layout patterns.

Layout 1: Normal printing

(with no margins depending on the printer)
Layout 2: Layout printing
Layout 3: Partition printing

(printing one image on multiple pages)

Images per page

From the list, select the number of images to print on
one page.

Multi-page printing

Select the number of partitions per page from the list.

Allocating images

Select processing options from the list when printing

area and image size differ.

No trimming:
The image does not exceed the printing
area.

Trimming: The entire printing area is used and any part
exceeding the printing area is deleted.




Iltem Description
Position Select the position of the image in the printing area
from the list.

Space (Vertical)/Space  Set the vertical and horizontal space in mm.
(Horizontal)

Fit to page This setting uses the printing area most effectively.
Check this to allow the image to be rotated 90° as
needed to fit the printing area and then printed.

Print Shooting Date and  Set the Shooting data/time print settings.

Time Position : Selects position to print Shooting date/
time.
Font : Select a font from the list. The default

setting is the standard system font.
Print Time: Select from Do Not Print (Default) or Print
(HH:MM, 24-hour format only).
Separator: Sets dividers in text.
Format : Sets date format.
Text color: Sets the font color.
Size : Select a font size from the list.

Printer The name of the printer to be used appears here.

_ @,

» The image size is calculated automatically from the margins, spacing, and
number of images.

» The printing orientation of the date/time depends on the image data (for
Windows only). The printing position is in a relative position to the image data.

« Click the [Page Setup] button to make the page settings. (p.57)

* Click the [Printer Settings] button to make the printer settings. (p.58)

&nemo

J  Click [OK].

Printing starts.



Using Page Setup

Use Page Setup to set printing options such as margins, headers/footers,
and number of copies.

’ Select [Page Setup] from the [File] menu in the PENTAX
PHOTO Browser 2.1 window or click [Page Setup] on the
[Print] dialog.

The [Page Setup] dialog appears.

Page Setup E]El
Margins
Left BEER Fiight [255] mm Number of capies
Upper [ =% m Lower [ =2 mm 15
Header [ 15 mm Foater [15%] mm
Headsr
Postion  [DoMNotFint =]  Font \ -
Text [
Insen Page Number | Inset No. of Pages | Size 10 =
Footer
Postion  [DoMotFint =]  Font -
Text [
Insen Page Number | Inset No. of Pages | Size 10 =
Piinter Setiings | [ ] Cancel \

Z Make the settings.

Item Description

Margins  Left, Right, The default setting is 25 mm on each side.
Upper, Lower
Header/ The default setting is 15 mm from the top and bottom
Footer edges.

Number of copies Specify the number of copies to print.

Header/  Text Enter text to print for the header/footer.

Footer

Insert Page When this is clicked, [#Page number] is inserted at
Number the cursor location in the Text field.

Insert Number When this is clicked, [#Number of pages] is inserted
of Pages at the cursor location in the Text field.




_ @,

ltem Description
Position Sets header/footer position. Select from Do Not Print
(Default), Align left, Align center, and Align right.
Font Select a font from the list. The default setting is the
standard system font.
Size Select a font size from the list. The default setting is
10 point.

J  Click [OK].

The page setup information is set.

Using Printer Settings

Check the printer settings and change the settings as needed.
Refer to the printer user's manual for details on printer settings.

i~  This section describes the printer settings for Windows. For Macintosh, the
printer setting screen is dependent on the OS.

’ Click [Print Setup] on the [Print] or [Page Setup] dialog.
The [Print Setup] dialog appears.

Print Setup @@

Frirter
RET=S

Status:
Type:
here:
Comment;

Paper

Size:

Source:

Metwork.... 0k | Cancel

Froperties. ..

Ready
EEFS SRR S
EEE SRR
Orientation
|44 210 % 297 mm = @ Porhrait
|Autu Selection j " Landscape




Z Make the settings.

Item Description

Name Select the printer to use from the list.
Click [Network] to select a printer on the network.
Click [Properties] to make advanced printer settings.

Paper Size Select paper size.

Source Select paper feeding method.
Orientation Sets printing direction. Select [Portrait] or [Landscape].
J  Click [OK].

The printer setup information is set.




Changing the PENTAX PHOTO Browser 2.1
Settings
Here, you can set the PENTAX PHOTO Browser 2.1 startup settings, such

as the initial image view size, thumbnail caption viewing, and RAW file
view format.

’ Select [Options] from the [Tool] menu in the PENTAX
PHOTO Browser 2.1 window.
Alternatively, click the [ icon on the Tool bar.

The [Options] dialog appears.

Options

Gieneral ]\r"iew | Frame dvance | Slideshow

Falder at Startup

* Last folder used
" Desklop

7 Always uzse this folder

[]

Status at Startup

+ Status at last exit

" Default

Show Splazh Screen at Startup
*+ On " 0K

Reszet agK | Cancel




[General] tab settings

Change the startup settings for PENTAX PHOTO Browser 2.1 in the

[General] tab.

ltem

Description

Folder at Startup

From the following, select the folder to open when
starting the program.
Last folder used:
This opens the folder that was last used in
PENTAX PHOTO Browser 2.1.
Desktop: This opens the desktop.
Always use this folder:
Click [Browse] to specify a folder.

Status at Startup

Set PENTAX PHOTO Browser 2.1 status at startup.

Status at last exit:
When the next session of PENTAX PHOTO
Browser 2.1 is started, the settings from the
previous session are used.

Default : The default screen appears.

Show Splash Screen at
Startup

Sets splash screen when PENTAX PHOTO Browser
2.1 starts.

On : Splash screen is shown.

Off : Splash screen is not shown.

L=~  The splash screen s the title screen that
appears when PENTAX PHOTO
Browser 2.1 starts.

PENTAX E=IEaxeX Browser™ 2.1
I
. _FI
- q,-I'_r_r‘—'
e
7

2

Copyright 52004 PENTAX Corporation
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[View] tab settings

Change the Main Image View window settings in the [View] tab.

Options

Image D ata Pane Height

* Last size specified
" Auto

" Fived
Rlows EI

Showing Multiple Images

= Single window

b ain RAMW File Image
* Simple display
" Auto RA display

General  Wiew ]Frame.-’-\dvancel Slideshow]

2

Main Image Window Size

¥ Last size specified
" Default

™ Set size

Width EI Height EI

7 Separate window

o] 7 -
Rezet ak. | Cancel
ltem Description

Image Data Pane Height

Sets the height of the Image data pane that appears

when the main image window opens.

Last size specified:
Sets Image data pane height to be the same as
the previous height when the main image view
window opens.

Auto : The height is automatically adjusted.

Fixed: The number of lines may be specified.

Main Image Window Size

Set the window size of the main image view window.

Last size specified:
Opens the main image view window to the
last window size specified.

Default : Opens the window to the default size.

Set size: Specifies the size of the main image window
in pixels.




ltem

Description

Showing Multiple Images

When multiple images are selected in the Thumbnail
pane, select the viewing method in the main image
view window.
Single window:
Images appear in one main image view window.
Click the icons on the Main image view
window Tool bar to switch the image view.
Separate window:
Images appear in multiple main image view
windows.

Main RAW File Image

Sets view when opening a new RAW image file.
Simple display:
The compressed image data in the RAW image
file appears. The image data appears more
quickly, but there is quality loss due to the high
compression rate. Therefore, this function is
not recommended for checking image details.
Auto RAW display:
The actual RAW data appears. (Full Auto
Processing)

Size (Ratio):
Select the processing ratio for Auto RAW a
display from [1:4], [1:2], or [Life size]. When
emphasizing speed, select [1:4]. When
emphasizing quality, select [Life size].
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[Frame Advance] tab settings
Change the main image view window frame advance settings in the

[Frame Advance] tab.

Options

v Zoom
¥ Position

¥ Direction

General] View  Frame Advance lSIideshow]

Wiew sttributes to b aintain

IX]

“Wiew Order

* File name
" Shooting date/ time

™ File date time

Reset

ak. | Cancel

ltem

Description

View Attributes to
Maintain

Selects view attributes to maintain during frame
advance. Multiple attributes may be selected.
Zoom : View magnification rate is maintained.
Position : Position is maintained.

Direction : Direction is maintained.

View Order

Selects ordering for frame advance.

Slideshow is played in the same order.

Select from the options below.

File name : Frames advance in file name order.

Shooting date/time:
Frames advance in shooting date/
time order.

File date/time : Frames advance in file date/time
order.




[Slideshow] tab settings
Change the slideshow settings in the [Slideshow] tab. (p.49)

Options @@
General] Wiew ] Frame &dvance  Slideshow ]
Shideshow Settings Interal
(* Single window

" Diual window

" Single full screen secandts) =
" Dual full sereen

Frame Adwance During Dual Yiew Loop wiew

(v Advance in arder

" Advance altemate * No

" Advance two frames " Yes

™ Set primary image

Rezet ak. | Cancel

ltem Description

Slideshow Settings Set the pattern when viewing slideshows.
Single window:
View slideshow in a single window.
Dual window:
View slideshow in two windows (primary and
secondary).
Single full screen:
View slideshow full-screen on a single monitor.
Dual full screen:
View slideshow full-screen on two monitors.

Interval Sets interval for frame advance during slideshows.
Second(s):
Sets interval (in seconds) for frame advance.




Iltem Description
Frame Advance During  Set the refresh method when viewing two images
Dual View simultaneously. (p.51)

Advance in order:
Frames advance in order. The secondary
window shows one image ahead of the primary
window.

Advance alternate:
At each frame advance interval, images are
shown alternately on the primary and
secondary windows. With the first image
starting at zero, even number images are
shown on the primary window and odd number
images are shown on the secondary window.

Advance two frames:
Frames advance in twos.

Set primary image:
The primary window shows a fixed image. The
secondary window shows images, which
advance in order.

Loop view Sets the repeat view setting.
No : When all of the images have been shown, the
D slideshow ends.
Yes : Even after a slideshow ends, the slideshow
repeats until B is clicked.

Z After making your selections, click [OK].
The options are set and the [Options] dialog closes.

Click [Reset] to return all options to default settings.

When [Reset] is clicked, all tab settings including the settings of the currently
open tab are returned to default settings.



Managing Image Files and Folders

Moving/Copying Image Files

’ In the Thumbnail pane of the PENTAX PHOTO Browser 2.1
window, select the thumbnail image to move or copy.

Select [Cut] or [Copy] from the [Edit] menu.

Alternatively, click the 2 or || icon on the Tool bar.

PENTAX PHOTO Browser,
File Nas[# Wiew Tool Help

d

e cut

~ 0 T

(B 1 7 Delete

Check Selected Image

Uncheck Selected Image

Select all

Invert Selection

o0 Es o BEFOE

x

+ 5 Control Pane
+-{7) Shared Documents
+-{(7) screen's Documents
+-{5) My Documents

¥ ‘3 My Metwork Places

gshtestimy documentshy picturesh1 00pents

O

IMGPO003.FEF
325/ 2005 1:43:08 Fh

O

IMGPO00S.PEF
3/ 25/20051:4%: 44 Ph

IMGPO007.JPG
325/ 2005 1:07:56 Ak

IMGFO023.PEF
3/ 26/2005 1:43:06 Pk

IMGFO025.PEF
3/25/20051:43:10 Ph

O

IMGROD30.PEF
3/26/2005 1:43:22 Pk

Specify the destination folder for moving or copying in the
Folder tree pane.



4 Select [Paste] from the [Edit] menu.
Alternatively, click the ] icon on the Tool bar.

PENTAX PHOTO Browser,
File N8 VYiew Tool Help

@

e cut

Ag |E Copy

3 IR
el 7 Delete
=

LA

& o | EZEREFOE

L
—

+ § Control Panel
+-{7) Shared Documents
+-{7) screen’s Documents
+-{7) My Documents
+ ‘:ﬂ My Network Places

gehtestimy documentsimy pictures

[~ |

o

TO0PENT




The image file is moved or copied to the specified folder.

PENTAX PHOTO Browser,
File Edit WYiew Tool Help

ORI IS IR & % o BEFOE

Address |c: Sdocuments and settingsitestimy documentshmy pictures ﬂ

@ Deskbop
= E} My Documents
My Music
= My Pictures
[C3) 100PENTX
(03 PENTAX
|- g My Computer
+- M 3 Floppy (a:)
+|-age Local Disk () 100PEMT IMGFO003. PEF
+1- OO Drive (D0 3/ 25/2008 1:43:08 Ph
+ Control Panel
+1-{) Shared Dacuments
+|-|C7) screen’s Documents
+-{5) My Dacuments
+ ‘g Iy Mebwork Places

=

O

.m0 ° Youcan also move an image by dragging and dropping a thumbnail image to
-~ the destination folder. To copy, hold down the Ctrl key while you drag and
drop the file. (For Macintosh, hold down the Option key while you drag and
drop the file.)
» Use the same procedure to move or copy a folder. In the Folder tree pane,
specify the folder to move or copy. The specified folder is moved or copied
into the destination folder.



Deleting Image Files/Folders

’ In the Thumbnail pane of the PENTAX PHOTO Browser 2.1

window, select the thumbnail image to delete.

Alternatively, select the folder to delete in the Folder tree

pane.

Z Select [Delete] from the [Edit] menu.

Alternatively, click the icon on the Tool bar.

PENTAX PHOTO Browser,

File N3l# Wiew Tool Help

@a%s Cut

A |E Copy
Ej Paste
10

b Check Selected Image

Uncheck Selected Image

= Select all

Invett Selection

+nd0nEe o EEFOS

=
="

+ -k CD Drive (D)
+ Contral Panel
+-{3) Shared Documents
+-{) screen's Documents
+-{5) My Documents

+ 'Iﬂ Iy Metwork Places

gzhtestimy documentshmy picturesh1 00pents

O

IMGPO003.FEF
3/ 25/2005 1:43:08 Ph

O

IMGPO00S.PEF
3/25/20051:4%:44 Ph

IMGPO007.JPG
3/25/2005 1:07:56 Ak

IMGFO023.PEF
3/ 26/2005 1:43:06 Pk

IMGFPO025.PEF
3/25/20051:43:10 Ph

O

IMGROD30.PEF
3/26/2005 1:43:22 Ph

A delete confirmation screen appears.

3 Click [Yes].

The image file or folder is deleted.



Changing Image File/Folder Names

’ In the Thumbnail pane of the PENTAX PHOTO Browser 2.1
window, select the thumbnail image to be renamed.
Alternatively, select the folder to be renamed in the Folder
tree pane.

Z Select [Rename] from the [File] menu.
Alternatively, directly click the file or folder name in the
Thumbnail pane or Folder tree pane.

The file or folder name is ready to be changed.

PENTAX PHOTO Browser
File Edit ‘iew Tool Help

QeI O+l Ee- o  BEEFOE

Address |c:\documents and settingshtestmy documentshmy picturesh] 00pents: j
x
@ Desktop
= [,D My Documents
=) My Music
] My Pickures
|75 100PENTY
|5) PENTAR
= i My Computer 0O 0
+ g 3% Floppy (A1)
+]-age Local Disk (C1) IMGPO003.PEF [mGFoo0s FEF[ | IMGPO007.JPG
414 CD Drive (D) 3/25/2005 1:49:08 Ph 3/26/2005 1:45%:44 Ph 3/26/2005 1:.07:56 Ah
+ Contral Panel

+-|7) Shared Documents
+-{5) screen's Documents
+-{5) My Documents

+- &3 My Metwork Places

O

O

IMGPO023. FEF IMGPO025.PEF IMGPO030.PEF
325/ 2005 1:43:08 Fh i 25/20051:4310 Ph 25/2005 1:43:22 Ph

3 Input the file or folder name.

The image file or folder is renamed.




Renaming All File Names

, In the Thumbnail pane of the PENTAX PHOTO Browser 2.1
window, select or check the thumbnail images to be

renamed.

Select [Select All] from the [Edit] menu to select all images in the
Thumbnail pane. Images from more than one folder cannot be selected.

Select [Rename All] from the [File] menu.

Alternatively, click the button from the tool bar.
The [Rename All] dialog appears.

Rename AlL..

Base file name

[~ Put baze fle name last

?

It 5H MNumber of digitz 43:

Start mumber a0m EI:
ak. | Cancel |

3 Confirm the content, and input information as needed.

ltem

Description

Base file name

Specify name to add to file names. “IMGP” is added by
default.

Number of digits

Specify the number of digits to add to file names. 1 to
5 digits may be specified. 4 digits are specified by
default. (Example: IMGP1234.pef) When files exist in
the folder with the specified base file name, the
number of digits increases if the maximum number of
files is exceeded.

Put base file name last

When this check box is checked, the file name
specified in [Base file name] is added to the end of all
file names. (Example: 0123IMGP.pef) Base name file
is added to the beginning by default.




ltem

Description

Start number

Sets the start number. When files exist in the folder
with the same specified base file name, the numbering
automatically starts from the number next to the
highest number of the existing file. If there is no file with
the specified base file name, numbering starts at 1.

4

Click [OK].

All files are renamed to the specified name.

Create a New Folder

1

In the Folder tree pane of the PENTAX PHOTO Browser 2.1
window, select the folder where to create a new folder.
Alternatively, select the Thumbnail pane.

Select [Create New Folder] from the [File] menu.

A new folder is created under the specified folder or in the Thumbnail pane.

+BAW

File Edit Wiew Tool Help

R17

- o EREFEOE

Address

=

‘c:\documents and gettingsitestymy documentsimy picturesi100pents:

- |

@ Deskiop
= @ My Documents
My Music
= My Pictures
) 100PEMTX
[0 PENTAR
= ¢ My Computer
+ & 3% Floppy (A:)
+-cg Local Disk {C:)
#-dy CD Drive (D)
3 Contral Panel
#)-{5) Shared Documents
#1-{J) screen's Documents
{5 My Documents
+-8d My Nebwork Places

L]

IMGPO00Z. PEF
3/26/2005 1:43:08 Ph

O

IMGPO00S PEF
3/25/2006 1:43:44 Ph

O

IMGPO02T.FEF
3/ 25/2005 1:43:20 Ph

L[]

IMGPO023.PEF
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IMGPO025.FEF
3/25/2005 1:43:10 Fh




%

memo

Displaying Properties of Image Files/Folders (for Windows)

The contents of the Properties dialog depends on the version of Windows
currently running. Refer to Help in Windows for details on the Properties dialog
settings.

’ In the Thumbnail pane of the PENTAX PHOTO Browser 2.1
window, select the thumbnail image for which properties
are to be shown.

Alternatively, in the Folder tree pane, select the folder for
which properties are to be shown.

Z Select [Properties] from the [File] menu.
The [XXX Properties] dialog appears.

imgp0025 Properties @@

General | summary

D —fﬁ MGPO0ZS

Type of file:  PENTAX Raw File
Opens wih:  &I] PENTAX PHOTO Brove

Location: Cri\Documents and Settings|testiMy Documentsim
Sice: 10,1 MB (10,614,217 bykes)

Size ondisk: 10,1 MB (10,616,832 bytes)

Created: Saturday, June 25, 2005, 2:29:51 AM
Modified: Friday, August 19, 2005, 1:48:10 FM

Amcessed:  Today, Sephember 09, 2005, 7:20:32 PM

attributes:  [Read-only  []Hidden

3 Confirm the content.

4 ciick [0K].

The Properties dialog closes.



Displaying Properties of Image Files/Folders (for Macintosh)

&nemo The standard Macintosh information dialog appears. Refer to Help in
Macintosh for details on the information dialog settings.

’ In the Thumbnail pane of the PENTAX PHOTO Browser 2.1
window, select the thumbnail image for which properties
are to be shown.

Alternatively, in the Folder tree pane, select the folder for
which properties are to be shown.

Z Select [Properties] from the [File] menu.
The [XXX Info] dialog appears.

80 IMGPO007.JPG Info

¥ General:

% IMGP0007.JPG

Ueec ]
Kind: JPEG Image
Size: 2.4 ME on disk (2,592,500 bytes)
Where: MC:lmage:
Created: --
Modified: Sat, Jun 25, 2005, 10:07 AM

! stationery Pad

! Locked

Name & Extension:

Open with:

Preview:

Ownership & Permissions:

Yy v vivvy

Comments:

3 Confirm the content.

4 Click the # button.

The Information dialog closes.



PENTAX PHOTO Laboratory 2.1

PENTAX PHOTO Laboratory 2.1 is software for color separation
processing and other processing of CCD RAW image data recorded in a
PENTAX digital camera dedicated format. The processing of RAW data
enables images to be viewed on commercially-available image viewing
and editing software.

This section describes opening and closing PENTAX PHOTO Laboratory
2.1 and viewing the PENTAX PHOTO Laboratory 2.1 window, and
explains its functions.

Opening PENTAX PHOTO Laboratory 2.1

For Windows

’ Select the start menu on the desktop.

Z Select [PENTAX PHOTO
Laboratory] from [PENTAX
Digital Camera Utility] in the
program menu.

PENTAX PHOTO Laboratory 2.1 is
opened, and the PENTAX PHOTO
Laboratory 2.1 window appears.

® Closing PENTAX PHOTO Laboratory 2.1

Select [Exit] from the [File] menu on the PENTAX PHOTO Laboratory 2.1
window.



For Macintosh

’ Double-click the [PENTAX PHOTO Laboratory] folder in
[PENTAX Digital Camera Utility] on the hard disk.

Z Double-click the [PENTAX
PHOTO Laboratory] program
icon.

PENTAX PHOTO Laboratory 2.1 is
opened, and the PENTAX PHOTO
Laboratory 2.1 window appears.

® Closing PENTAX PHOTO Laboratory 2.1

Select [Quit PENTAX PHOTO Laboratory] in [PENTAX PHOTO
Laboratory] on the desktop menu bar.

L=~ PENTAX PHOTO Laboratory 2.1 can also be started from within PENTAX
PHOTO Browser 2.1. (p.29)




About the PENTAX PHOTO Laboratory 2.1
Window

This section explains the PENTAX PHOTO Laboratory 2.1 window layout,
names, and functions.

PENTAX PHOTO Laboratory 2.1 is made up of five panels.
The panels appear in independent windows and may be placed anywhere

on the screen. Select [Arrange Windows] from the [View] menu to align the
panels.

Four panels, not including the main panel, can be hidden or shown.

Preview panel Main panel

Menu bar Tool bar

 Pres

% | I PENTAX PHOTO Laboratory.

File View Tool Help

E]@ i | €

\white B alance Seftings
% Camera setting Automatic

© Overide
€ Gray point setting ’

e (5) =

i

e
ﬁ"ﬁ
Sensitiiy A
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-3 a 3 Histoaram
Sstustion e —— [Brightness ~
=3 0 3
Sharpness — Show White Portions
_ @) N
| Show Black Portions
o e Reset ‘
I &
Other settings panel Tone panel White balance panel

* When the processing mode is set to Full Auto Processing mode lal, the
White balance panel, Tone panel, and Other settings panel do not appear.
(p-82)

* When RAW image data is not selected, the preview image does not appear.
(p-83)



® Main panel

This executes functions or sets various settings of PENTAX PHOTO
Laboratory 2.1.

For Macintosh, the Main panel only contains the Tool bar. The Menu bar
appears at the top of the desktop.

® Preview panel

View the selected RAW image in four steps, show specified areas
enlarged, and preview adjustments from the other panels.

View adjustments in real time or by clicking the Refresh button.

® White balance panel

Select white balance or set color temperature. Adjust the image color tone,
such as when the image appears bluish or yellowish. (p.88)

® Tone panel

Displays tone curve and histogram information of displayed image. (p.89)
Adjust the image tone using the tone curve.

® Other settings panel

Adjust characteristics such as sensitivity, contrast, color depth, and edges.
(p.90)

® Menu bar

This executes functions or sets various settings of PENTAX PHOTO
Laboratory 2.1.

File menu

Open This selects the image file for processing in PENTAX
PHOTO Laboratory 2.1. Only applies when the software
is started as standalone. This cannot be used when
PENTAX PHOTO Laboratory 2.1 is started within the
PENTAX PHOTO Browser 2.1 window. (p.84)

Save This performs RAW image data processing and saves it
with the specified format. The available save formats are
JPEG (5 compression rates), TIFF-8, and TIFF-16. Use
[Save Mode] on the [Tool] menu to specify the save
format. (p.91)

Recall Adjustment Use this function to load previously saved settings for
the various panels. (p.93)

Save Adjustment Use this function to save the settings currently used in
the various panels. (p.93)




File menu

Exit This closes PENTAX PHOTO Laboratory 2.1.
(For Macintosh, select [Exit PENTAX PHOTO
Laboratory] on the [PENTAX PHOTO Laboratory]
menu.)

View menu

Full Auto Processing

Custom Processing

First Image
Previous Image
Next Image

Last Image
Refresh Preview
Display Size
Preview

White balance
Tone

Other settings
Arrange Windows

AllRAW images are processed using specified settings.
All panels, except the Preview panel, are hidden. (p.86)

This performs processing using the processing
condition settings specified by the user. The processing
conditions are set using the White balance panel, Tone
panel, and Other settings panel. (p.87)

When multiple images are selected, the preview of the
first image in order of registration appears.

When multiple images are selected, the preview of one
image ahead in order of registration appears.

When multiple images are selected, the preview of one
image back in order of registration appears.

When multiple images are selected, the preview of the
last image in order of registration appears.

When real-time preview is not enabled, the preview is
refreshed using the current settings.

This specifies the size of the image data in the preview.
This shows or hides the Preview panel.

This shows or hides the White balance panel.

This shows or hides the Tone panel.

This shows or hides the Other settings panel.

This arranges the displayed panels.

Tool menu

Undo

Redo

When in Custom Processing mode, use this function to
cancel the previous operation. You can undo up to five
operations.

When in Custom Processing mode, use this function to

redo an operation that was cancelled with the [Undo]
button.




Tool menu

Image Mode Select types of image modifications. When Full Auto
Processing is set, images are processed using
individual file settings. When in Custom Processing
mode, all images are processed using the selected
processing mode. Some modes may not be able to be
set depending on the RAW file type.

Save Mode This sets the quality when saving processed images.
Save images in JPEG format with one of five different
compression rates or in TIFF format with one of two bit
types. The default setting is JPEG (Highest Quality).

Save Size This sets the size in pixels when saving processed
images. (p.91)
Options This sets various settings for PENTAX PHOTO

Laboratory 2.1. (p.94)

Help menu

Help Topics This shows PENTAX PHOTO Laboratory 2.1 help
contents.

Index This shows PENTAX PHOTO Laboratory 2.1 help index
search. (This command is not available for Macintosh.)

What's This? This shows pop-up tips.

About PHOTO This shows PENTAX PHOTO Laboratory 2.1 version

Laboratory information. (For Macintosh, select [About PENTAX
PHOTO Laboratory] on the [PENTAX PHOTO
Laboratory] menu.)

Tool Bar

This executes functions or sets various settings of PENTAX PHOTO
Laboratory 2.1.

1 2 3 4 5 6 7 8 9 10 11 12
|H£7[%} @ - ELJlMaI
Number Icon (button) Content
1 C This selects the image file for processing in PENTAX
‘vfj PHOTO Laboratory 2.1. Only applies when the

software is started as standalone. This cannot be used
when PENTAX PHOTO Laboratory 2.1 is started within
the PENTAX PHOTO Browser 2.1 window. (p.84)

Open

o



Number Icon (button)

Content

2 This performs RAW image data processing and
IB saves it with the specified save mode and image size.
Save (p-91)
3 = This appears when Full Auto Processing is set.
LL@ T Performs processing using the processing conditions
Full Auto set in the RAW file.
Processing Click F to select [@ or [« from the pull-down menu.
This is displayed when Custom Processing is set.
L’_@ M This performs processing using the processing
Custom condition settings specified by the user. The
Processing processing conditions are set using the White
balance panel, Tone panel, and Other settings panel.
(p.87)
4 _ When in Custom Processing mode, this recalls a
I-gfj saved adjustment file. (p.93)
Recall
Adjustment
5 This saves the processing conditions set in Custom
@ Processing mode as an adjustment file. (p.93)
Save Adjustment
6 When in Custom Processing mode, use this function
@ to cancel the previous operation. You can undo up to
Undo five operations.
7 When in Custom Processing mode, use this function
@ to redo an operation that was cancelled with the
Redo [Undo] button.
8 e This displays the current Image mode. When Full
L! T Auto Processing is set, images are processed using
Image Mode individual file settings. When in Custom Processing
g mode, click ™ to select the Image mode. All images
are processed using the selected processing mode.
Some modes may not be able to be set depending on
the RAW file type. (p.86)
9 oo This displays the current Save mode. Click [ to
rriT I select the save format for the processed image file.
Save Mode (p-91)
10 This displays the current Image mode. Click [ to

[~

Image Size

select the size of the processed image file. (p.91)




Number Icon (button)

Content

11 This is used to change the PENTAX PHOTO
Jl@ Laboratory 2.1 settings. (p.94)
Options
12 ? This shows PENTAX PHOTO Laboratory 2.1 help
ek contents.
Help

Preview Panel

This shows a preview of the RAW file.

Preview

imgp0492. pef

Number Icon (button)

Content

1 Click [ to select the size of the image data in the
al™ preview from the pull-down menu.
: . Select from [4 Small, [ .= Medium, = Large, or

Display Size 1 Full Size.

2 When this is turned on, a red frame appears in the
q preview area. The Enlarge area window appears
Enlarge Area and the magnification can be selected.

3 Click this to refresh the preview using the current

[2)

Refresh

settings when [Refresh Preview] becomes the
[Refresh] button on the Options settings of
PENTAX PHOTO Laboratory 2.1.




Number Icon (button)

Content

4 maere = \When multiple images are selected, select the
image to display from the list.

5 When multiple images are selected, the preview
E<< of the first image in order of registration appears.
First Image

6 When multiple images are selected, the preview
< of one image ahead in order of registration
Previous Image appears.

7 When multiple images are selected, the preview
D’ of one image back in order of registration
Next Image appears.

8 When multiple images are selected, the preview
PN of the last image in order of registration appears.
Last Image

Viewing Images

’ Click the 7 button in the PENTAX PHOTO Laboratory 2.1

window.

The [Open] dialog appears.

Open

B

Look in: | 2 100PENT:

RAW

x|« @k Er

RAW RAW

IMGPO00S IMGPO0z1

b

File name: |

Files of type: |PENT.&>< RaW File [*.PEF)

| Cancel

Z Specify the file name of a RAW image file to display and
click the [Open] button.



A RAW image appears in the Preview panel of the PENTAX PHOTO
Laboratory 2.1 window.

:
o 2 1] < M

Select multiple image files to open multiple images at the same time.

Click the [, [<], [P], or Pl button on the Tool bar to preview the desired
image.

i=~  When starting PENTAX PHOTO Laboratory 2.1 from PENTAX PHOTO
Browser 2.1, use the following methods for viewing image files. Select RAW
image files in PENTAX PHOTO Browser 2.1, then start PENTAX PHOTO
Laboratory 2.1. RAW image files can also be selected in PENTAX Photo
Browser 2.1 after PENTAX PHOTO Laboratory 2.1 has been started.

To select multiple image files in PENTAX PHOTO Browser 2.1, check the
thumbnail images or press and hold the Ctrl key as you left click on thumbnail
images you want to select. (For Macintosh, hold down the Command key and
click thumbnail images to select multiple images.) Files can be selected using
the check boxes if there are no files checked and selected (indicated by a
blue frame) when PENTAX PHOTO Laboratory 2.1 is started.

Opening PENTAX PHOTO Browser 2.1

’ Select a RAW image in the PENTAX PHOTO Browser 2.1
window.

Z Select [PENTAX PHOTO Laboratory] on the [Tool] menu of
PENTAX PHOTO Browser 2.1 or click the icon.

A RAW image appears in the Preview panel of the PENTAX PHOTO
Laboratory 2.1 window.



Easily Modifying RAW Images

Select an Image mode to easily process RAW images according to
shooting conditions.
When in Full Auto Processing mode, RAW images are processed using
the Image mode selected at the time of capture. This setting cannot be
changed in PENTAX PHOTO Laboratory 2.1.

When in Custom Processing mode, the Image mode can be selected. All
frames are processed using the same selected Image mode.

Select from the following seven Image modes when using #éa£ DL :

Natural Elaborates images with natural colors.
l_!_l
I—E Bright Elaborates sharp, bright images.
E Picture (Portrait) Elaborates images with beautiful skin tones.
Picture (Landscape) Enhances the contour and saturation of images
‘ with greenery, blue sky, etc., to create images
with bright colors.
Picture (Macro) Elaborates images with vivid close ups of flowers
\‘ and other objects.
Picture (Moving Elaborates sharp images of fast-moving objects.
R\ Object)
P Picture (Night Scene For capturing people against the background of
- Portrait) sunsets or night scenes.




Setindividual processing conditions to create unique image modifications.

1

‘?nemo

Setting RAW Image Data Processing
Conditions

Select [Custom Processing] from the [View] menu, or click
~ on the icon on the Tool bar and then click
(Custom Processing) on the drop-down list.

The Main panel, Preview panel, White balance panel, Tone panel, and
Other settings panel appear.

X | i PENTAX PHOTO Laboratory
Fie WYiew Tool Help

White Balance Seltings —
@ & Camera setting Automatic
1 Dveride
R 12
" Gray point setting o
6 32
& (3] c t Fe
2
= 1 4| > M| —
Sensitivly L —
32 4 01 2 3 == g@
Contrast e —
3 o 3 Histagram
Saturation — Brightress -
3 ] 3
Sharpness ., Show Wwhite Portions
3 0 3
Show Black Partions
w Reset ‘

To close the White balance panel, Tone panel, or Other settings panel, select
[Full Auto Processing] from the [View] menu, or click = on the icon on the
Tool bar and then click (Full Auto Processing) on the drop-down list. The
image is processed using the Image mode set at the time of shooting, and the
settings cannot be changed in PENTAX PHOTO Laboratory 2.1.




Z Enter settings in each setting panel.

The settings are reflected in the Preview panel. There are two ways to
reflect the settings. (p.94)

* Reflect the settings immediately in real time.

* Reflect the settings when clicking the icon on the Preview

panel.

® Setting the White balance

White Balance

‘wWhite Balance Settings

&+ Camera setting Automatic

" Dveride

" Gray point setting

i+ o

Iltem

Content

White Balance Settings

Select from the following:
Camera setting:

Override:

Apply the white balance setting used on
your camera.

Use [White Balance Setting] to select the
white balance to apply. Select from
[Daylight], [Shade], [Cloudy], [Daylight
fluorescent light], [Neutral white fluorescent
light], [White fluorescent light], [Tungsten
light], [Flash], or [Color temperature
setting].

Grey point setting:

Select the pointin the preview image to turn
gray. Specify using the pointer for the most
appropriate white balance setting. Select
from 1 point, 3 points, or 5 points. When
shooting with the gray panel with Grey point
setting, a more accurate white balance may
be achieved. Click [Reset] to delete the
selected gray points.




ltem

Content

Color temperature

This can be set when selecting [Color temperature
setting] with [Override] from [White Balance Settings].
Color temperature:
Slide the bar to set the color temperature or
select the setting from the list. Select from
between 2500K to 10000K (in Kelvin).
Fine tune: Use Fine tune to correct errors in color
during shooting using the Amber, Blue,
Magenta, and Green slide panels. The fine
tuned areas are not reflected in the color
temperature display.

® Setting the Tone curve/Histogram

Tone

Histogram

Show Wwhite Portions |

Shaw Black Partions

M\—‘\-l‘[ Fesat |

Iltem

Content

Tone curve

Adjust the tone curve to make precise adjustments to
the density and contrast. Change the tone curve using
the pointer. Move the curve up to brighten and move
the curve down to darken the image.

Click a point on the tone curve to fix the curve at that
point. A black dot appears. Drag the black dot to move
the fixed location. Right-click to erase the black dot.
(For Macintosh, hold down the Ctrl key while you drag
the black dot.)

Histogram

Brightness shows the distribution of luminosity when
combining RGB, R (Red), G (Green) and B (Blue).

[Show White Portions]/
[Show Black Portions]

Click [Show White Portions] to show white portions of
the image on the Preview panel in black.
Click [Show Black Portions] to show black portions of
the image on the Preview panel in white.

[Reset]

Deletes the tone curve settings, and returns to a
straight line.




® Setting the Sensitivity/Contrast/Saturation/Sharpness
Set these using the Other settings panel.

Other, Settings

Sensitivity

Contrast

Saturation

Sharpness

RIX

ltem

Content

Sensitivity

Changes the sensitivity of processing.
+: The image becomes brighter.
—: The image becomes darker.

Contrast

Adjusts the contrast between light and shadow.
+: Increases contrast between light and shadow.
—: Decreases contrast between light and shadow.

Saturation

Adjusts the strength of the colors after RAW data
development.

+: The colors become stronger.

—: The colors become weaker.

Sharpness

Adjusts the sharpness of the edges.
+: Image contour is enhanced.
—: Image contour is softened.




Saving Image Files

You can save the image files which have been Full Auto processed or
Custom processed. Specify the save format and image size when saving
image files. Save images in JPEG format with one of five different
compression rates, or in TIFF-8 or TIFF-16 format.

As the compression rate increases, the file size decreases, but the quality
also deteriorates.

Select from S, M, or L for the image size.

Size Pixels
3008x2008
E 2400x%1600
@ 1536%x1024

’ Select [Save Mode] from the [Tool] menu, or click ~ on the
right of the icon to select the save format.

Select the quality and file format when saving RAW images.

For JPEG files, image data is compressed and saved. Select from

Highest Compression, High Compression, Medium Quality, High Quality,

and Highest Quality. Select High or Highest Compression to make the

file size smaller by lowering quality. Select High or Highest Quality to

maintain high quality by keeping the file size large.

Select TIFF-8 or TIFF-16 to avoid quality loss due to compression.

Although selecting TIFF-16 leads to a larger file size, quality loss is (,
minimized when modifying the file with other image editing software.



Q PENTAX PHOTO Laboratory.
Fle view Tool Help
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IPEG {High Compression)

. IPEG {Medium Quality)
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2 Select [Save Size] from the [Tool] menu, or click ~ on the
right of the icon to select the save size.

ﬂ PENTAX PHOTO Laboratory:
File View Tool Help

dO @ @ TR R A

E Medium
@ Small

17 Select [Save] from the [Tool] menu or click the iconon
the Tool bar.

The [Save as] dialog appears.

Save... @
Savein | ) 100PENT ~| « & E-
-~
IMEPODO7 IMGPOOOS IMGPO013S

v

Save astype: |JPEG [Highest Quality) | Cancel J,\

File: name:

4 Specify the file name and save destination, and then click
[Save].

The image file is saved.



&nemo When [Use queue list] is set in [Options], the image file is added to a queue list.

Saving Image File Adjustment

All current adjustment combination can be saved as a parameter file. Saved
adjustment can then be applied to other RAW images for processing.

’ Click [Save Adjustments] from the [Tool] menu on the
Main panel or click the icon.

The [Save Adjustments] dialog appears.

Save Adjustments E]@
Save ir; | "_} ty Documents j I‘j( '
jMy Music
ﬂMy Pickures
|[CIPEMTAX
File name: | v |
Save astype: [Adjustment Fie (*INI] - Cened)

Z Specify the file name and save destination, and then click
[Savel].

The current settings are saved as an adjustment setting file (*.INI). a

Recalling Image File Adjustment

, Display a RAW image file in the Preview panel.

Z Click [Recall Adjustment] from the [Tool] menu on the
Main panel or click the icon.

The [Open Adjustment File] dialog appears.



3 Select a folder and parameter file name, and then click
[Open].

The current RAW image is processed by the recalled adjustment.

Changing the PENTAX PHOTO Laboratory 2.1
Settings

’ Select [Options] from the [Tool] menu on the Main panel or
click the icon on the Tool bar.

The [Options] dialog appears.

Z Click the [General] tab.

Change the settings as needed.

Options EJE

General ] Advanced ]

Folder to Use
' Folder with original file
7 Always use this Folder
Statug at Startup Show Splash Screen at Startup
(% Status af last exit
* On
" Arange Al
0O
" Default
D Arange Panels
 Align left " Align right
Put in Secondary Monitar Except Preview
* 0On 0

Reset Ok | Cancel




ltem

Content

Folder to Use

Select from one of two folders to use.

Folder with original file:
The folder with RAW data is used.

Always use this folder:
Click [Browse] to display the [Browse for
Folder] dialog, and then select the folder to
use.

Status at Startup

Select the status at startup.

Status at last exit:
Maintains the settings last used when the
application was closed.This switches to
[Arrange All] when, for example, the settings
last used cannot be restored due to a
difference in the number or type of monitors.

Arrange All:
All panels to be used are arranged. Display
size is set to Small (default setting), and other
settings are displayed with the status at last
exit.

Default: The status for each panel is returned to the
default status.

Show Splash Screen at
Startup

Sets splash screen when PENTAX PHOTO
Laboratory 2.1 starts.

ON : Splash screen is shown.

OFF : Splash screen is not shown.

Arrange Panels

Sets whether panels are aligned to the right or left
when automatically arranging the panels.

Put in Secondary Monitor
Except Preview

Set this to [ON] to arrange the White balance panel,
Tone panel, and Other settings panel on the
secondary monitor. In this case, the Arrange Panels
option is ignored.

L The splash screen is the title screen that
appears when PENTAX PHOTO
Laboratory 2.1 starts.

memo,
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J  Click the [Advanced] tab.

Change the settings as needed.

Options @@

General Advam:edl
Color Space Processing
* sRGE & Start immediately

" AdobeRGE " Use queue list

Refresh Preview

* Real time

" Refresh button

Saving Multiple Files

(% Diiginal file name + new extension

" MNumbered files

=1
" Save one at a time
Reset kK | Cancel
Item Content
Color Space Select from [sRGB] or [AdobeRGB] for the color space
that sets the color range.
sRGB:

This is currently the most common color space
setting and is compatible with most monitors and
image processing software.
AdobeRGB:
This offers a wider range of color than [sRGB].
Use this setting for tasks such as making detailed
D adjustments on images or commercial printing.

When viewing images processed with AdobeRGB in an sRGB environment,
the saturation may appear lower than when processed with SRGB.

Processing Select from starting processing jobs immediately or
creating a queue list and starting jobs later.
Start immediately:
Jobs are started immediately. Other operations
cannot be performed until processing is completed.
Use queue list:
Jobs are added to a queue list. Jobs may be
added or deleted before processing or during
processing.




ltem Content

Refresh Preview Real time:
Set this to apply processing conditions to the
preview image upon each change made to
[Custom Processing] settings.

Refresh button:

Set this to apply processing conditions to the
preview image after all changes are made to
[Custom Processing] settings, upon clicking the
[Refresh] button.

Saving Multiple Files Select the saving method when processing multiple
images, from the following choices: [Original file name
+ new extension], [Numbered files] and [Save one at a
time].
Select Numbered files to specify the base file name
and the number of following digits.

4 After setting each item, click [OK].
The options are set, and the dialog closes.

Click [Reset] to return all options to default settings.

When [Reset] is clicked, all tab settings including the settings of the currently
open tab are returned to default settings.




Glossary

AdobeRGB

This color space is recommended for commercial printing and document
creation by Adobe Systems (US). Its color reproduction range is larger
than sRGB and adequately covers the color reproduction range for
printing. Therefore, color data only reproducible on a printer are not lost
when editing on a computer. Note that using AdobeRGB with unsupported
software causes colors to appear faint.

CCD RAW data

CCD stands for Charge Coupled Device, a semiconductor device that
converts optical information into electrical signals. RAW image data is raw
data recorded from CCD output. This data can be transferred to a
computer, and manipulated into image data with unique settings such as
JPEG and TIFF using supplied software.

CSV format

This data format lists recording fields and separates them with a comma
(,). Generally, character strings are indicated with double quotation marks
in CSV format. Some software include data input and output functions in
CSV format as part of a multipurpose format.

Exif-JPEG format

Exif stands for Exchangeable Image File Format. This image file format is
based on the JPEG image data format, and allows thumbnail images and
image properties to be embedded into the data. Software that does not
support this format processes the image as a regular JPEG image.

Exif-TIFF format

Exif stands for Exchangeable Image File Format. This image file format is
based on the TIFF image data format, and allows thumbnail images and
image properties to be embedded into the data. Software that does not
support this format processes the image as a regular TIFF image.

JPEG
An image compression format. Although the image quality deteriorates a
little, images can be compressed to a smaller file size than with TIFF and

D other formats.



Lossless rotation

Because JPEG uses irreversible compression (data is lost during
compression), the quality of JPEG images deteriorates when
uncompressed, rotated and then saved. Lossless rotation, however, can
be used to rotate JPEG images without recompressing the data. Exif and
other data are maintained. Images for which lossless rotation is performed
are processed as separate files; the rotated image appears after the image
file is saved.

PNG format

Images saved using this format can be compressed to a small file size, but
the reversible compression of this format makes the file size larger than
JPEG. This format is for use with full-color images and prevents quality
loss even when re-edited. PNG files, however, cannot be viewed on older
browsers (Internet Explorer 3.0 or earlier or Internet Explorer 4.5 on
Macintosh). In addition, thumbnail images and image properties cannot be
embedded in the data.

sRGB (standard RGB)

An international color space standard defined by IEC (International
Electrotechnical Commission). This is defined from color space for
computer monitors and is also used as the standard color space for Exif.

TIFF-8

A file format for saving image data. Each image is recorded with 8-bit RGB
data for each color. The image is not compressed making the file size
large, but no deterioration of image quality occurs.

TIFF-16

Although TIFF images are usually 8-bit, this is a 16-bit TIFF. More
computations are required when image processing as the dynamic range
is larger.
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